INTRODUCTION TO CLOUD COMPUTING

What is Cloud Computing?

Cloud computing means that instead of all the computer hardware and software you're

using sitting on your desktop. or somewhere inside your company's network. it's provided for

you as a service by another company and accessed over the Internet. usually in a completely

seamless way. Exactly where the hardware and software is located and how it all works

doesn't matter to you. the user—it's just somewhere up in the nebulous "cloud" that the
Internet represents.

Cloud computing is a buzzword that means different things to different people. For some,
it's just another way of describing IT (information technology) "outsourcing”; others use it to
mean any computing service provided over the Internet or a similar network: and some define
it as any bought-in computer service you use that sits outside your firewall.

Types of cloud computing

IT people talk about three different kinds of cloud computing. where different services

are being provided for you. Note that there's a certain amount of vagueness about how these

things are defined and some overlap between them.

L.

Infrastructure as a Service (IaaS) means you're buying access to raw computing
hardware over the Net.such as servers or storage. Since you buy what you need and
pay-as-you-go, this is often referred to as utility computing. Ordinary web hosting is a
simple example of IaaS: you pay a monthly subseription or a per-megabyte/gigabyte
fee to have a hosting company serve up files for vour website from their servers.

Software as a Service (SaaS) means you use a complete application running on
someone else's system. Web-based email and Google Documents are perhaps the best-
known examples. Zoho is another well-known SaaS provider offering a variety of
office applications online.

Platform as a Service (PaaS) means you develop applications using Web-based tools
so they run onsystems software and hardware provided by another company. So. for
example, you might develop your own ecommerce website but have the whole thing,
including the shopping cart. checkout, and payment mechanism running on a
merchant's server. App Cloud (from salesforce.com) and the Google App Engine are
examples of PaaS.



Task-1

Programs on SOFTWARE AS A SERVICE

1. Create an word document of your class time table and store locally and on the cloud
with doc,and pdf format . ( use www.zoho.com and docs.google.com)

AIM: To create a word document of class time table and store locally on the cloud with
using ZOHO and Google docs.

Steps:

1. Go to docs.google.com
2. Select main menu >  Click Docs option and select Blank Document.
3. Write the title name is Annamacharya Institute of & Technology & Sciences, Tirupati (Al address)

4. Write the sub title name is IV.B.Tech TIME TABLE FOR ACADEMIC YEAR 2019-2020 at (A2
address)

5. Write the date is =Today() at G3 address
6. Write the fields A4 address to J4 address location

| I m W Tl VI VI
1
9:009:50 0:80 10:40 10:40 10:50 11:40  11:40-12:30 12:30- 1:20-2:10 2:10-3:00
= 1:10 310
10:50 400

In the above format the DAY/TIME will appear as above and go to Format cells and

select Alignment .In that under the Text control select tickon wrap text then click on
OK button

Write the MON at AS address location and drag cell with auto fill option up sat(A10
addess)

8. Write subject name GCC fill all cellsif you have lab hour’s like GCC LAB. Enter the
lab name leave 2 cells.

9. If any break or lunch leave the cell



FormattingStyles:

1. Select the cell Al to J1. click on HOME then click the merge and center button. set
font size to 16.

2. Select the cell A2 to J2. click on HOME then click the merge and center button. set
font size 1s 12.

3. Select the cell address G5 to G10. click on merge and center button. then type

“LUNCH" and click on orientation button &select “Vertical Text™.

Fill the cellswith particular subjects according toschedule.

Write “GCC™” in B5. “Maths™ in C35 and so on.

Select D5&DG6, click on merge &center button then type “BREAK™. click on

orientation & select “"Vertical Text™.

7. Select H5, I5.75 cells & type “GCC LAB™.

8. Repeat above steps for the remaining cells BS to J5.
Create a new document

AN o

Y¥ou can create a new document right in Docs or in Google Drive.
In Docs, click Create new document.

In Drive, click New > Google Docs > Blank document or From a template.

Import and convert old documents to Docs

If you have existing text documents, such as Microsoft® Word® or Adobe®PDF files, you can import and
convert them to Docs.

s Go to Drive.
s (lick New > File Upload and choose a text document from your computer. Supported
files include .doc, .docx, .dot, .html, plain text {.txt), .odt, and .rtf.
e Right-click the file you want to convert and select Open with > Google Docs.
Converting your document from another program creates a copy of your original file in Docs format. You

can then edit it in your browser like any other document.



Share documents

1. Open the file you want to share.
2. Click [SiE|.
3.  Enter the email addresses or Google Groups you want to share with.
Note: If you can't add people outside your company, see your G Suite administrator.

4. Choose what kind of access you want to grant people:
o Gan edit—Collaborators can add and edit content as well as add comments.
o Can comment—Collaborators can add comments, but not edit content.
o Gan view—People can view the file, but not edit or add comments.
Click 5end.

Everyone you shared the document with receives an email with a link to the document.

OUTPUT:

Result:

Task-2

2. Create a spread sheet which contains employee salary information and calculate
gross and total sal using the formula

DA=10% OF BASIC

HEA=30% OF BASIC

PF=10% OF BASIC IF BASIC==3000 12% OF BASIC IF BASIC=3000

TAX=10% OF BASIC IF BASIC<=1500

=11% OF BASIC IF BASIC=1500 AND BASIC==2500

=12% OF BASIC IF BASIC=2500

( use www.zoho.com and docs.google.com)

NET SALARY=BASIC SALARY+DA+HRA-PF-TAX



AIM: To create a spread Sheet contains employee salary information .

Steps:

1. Navigate to Google's home page and click on Google Does. Sign in if you have an
account.
Select main menu 2 Click sheets option and select Blank Document.

3. Enter Employee details from Al to J1.

4. At last select Al to J10 cellsand keep borders by clicking on Borders Button and
select All Borders.

5. Write formulas in formula box “fx”.

SNO | EMP | Designation | Basie | DA | HRA | PF | TAX | Net Gross

NAME Salary Salary | Salary
S.NO EMP NAME Desigantion Salary
1 A Manager 70000
2 B Project Manager 60000
3 C Project Lead 50000
4 D Team lead 40000
5 E Sr.Developer 30000
6 F Developer 1 20000
7 G Developer 2 20000
8 H Developer 3 20000
9 I Tester 20000
10 J Production 20000

Find DA HRA PF.TAX and NET SALARY
6. DA=10% OF BASIC
Ex: DA=Basic Salary*10/100



7. HRA=30% OF BASIC
Ex: HR A= Basic Salary*30/100

8. PF=10% OF BASIC IF BASIC<==3000 12% OF BASIC IF BASIC=3000
Ex: PF= =if(D2<=3000,D2*10/100,D2*12/100) (D2=Basic Salary)

9. TAX=10% OF BASIC IF BASIC=<=1500=11% OF BASIC IF BASIC=1500 AND
BASIC<=2500=12% OF BASIC IF BASIC=2500
Ex:
TAX
=If{D2<=1500.D2%10/100.1f{D2>1500&D2<=2500.D2*11/100.1f(D2>2500.D2%12/1
00)))

10. Net Salary=Salary+DA+HRA-PF-TAX
Ex: Net Salary=D2+E2+F2-G2-H2

11. Gross Salary= Salary+tDA+HRA+PF+TAX

12. At last save the file by clicking “Make a copy™ or ©* Down load as™ or “Email as
attachment™. give file name as Time Table then press “ok™.

OUTPUT:

Result:



Task-3

3. Prepare a PPT on cloud computing — introduction, models, services, and architecture
Ppt should contain explanations, images and at least 20 pages
( use www.zoho.com and docs.google.com)

Aim: To create a ppt on cloud computing using ZOHO & Google docs.

PROCEDURE:

Inserting a Slide:
Toinsert a new slide. ..
# From the Home tab. select “New Slide”

7 Aswell. you can right-click between any 2 slides in the preview frame located on the
left-hand side of the window

# Normal view and select “New Shide”

Deleting a Slide:
To delete a slide...
» As well, you can right-click on any slide in the preview frame located on the

left-hand side of the Normal view and select “Delete Slide™

Inserting Pictures:
To insert pictures. ..
# From the Insert tab you can insert pictures from your computer, images, clip art,

shapes, ete...
» Also. when you have a blank slide (or parts of a blank slide), you can also click
on options within these blank compartments to insert pictures.

Inserting Charts:
To insert charts. ..
# From the Insert tab you can insert pictures from your computer. clip art, shapes,

ete. ..
# Also. when you have a blank slide (or parts of a blank slide), you can also click on

options within these blank compartments to insert charts,



Steps:

ok WM

6.

Navigate to Google's home page and click on Google Docs. Sign m if you have an
account.
Select main menu-2click option =2 select Blank document.

Ppt should contain explanations, images and at least 20 pages

In first slide enter title name and sub-titles

In second slide. write introduction in title box and information in text box as point
wise

In next slides. write models. services. and Architecture

Formattinge stvles

Apply Formatting Styles (font size, font style. font type. and color). Bullets and

Numbering for the title and text from Format tab.

7. From the Insert tab, write the Slide number

8 Taka the picture from the Insert tab.

9. Select the theme and Background Color for the slides.

10. Select Transition to this slide and Transition sound.

11 From the insert tab. apply Animation for the Title, Text and picture from
Animations box. If you want more go to the custom animation tab.
e e e e e e e e

12. At last save the file by clicking *Make a copy™ or * Down load as™ or “Email as
attachment”, give file name as Time Table then press “ok™.

OUTPUT:

Result:



Task-4

#. Create your resume in a neat format using google and zoho cloud
ATM:

PROCUDURE

1. Navigate to Google's home page and click on Google Does. Sign in if you have an
account.

| ]

Click on “Template Gallery™ to see a list of template options. There are multiple letter
formats you can use for your cover letter, and multiple resume formats as well. You
can find additional templates by clicking the “More™ arrows and scrolling through the
options.

3. Select a template you like. Click on the template you want to use, and it will open in a

new window.

4. Personalize the template with your information. The templates are filled with lorem
ipsum dummy text. Simply click where you want to edit. delete the dummy text and

The template name appears at the top of your sereen. above the toolbars.

# For example. if you selected the basic Resume template. “Resume™ appears above
the toolbars.

# To rename the file. simply click on the template name. It opens in a textbox for
editing. After you've changed the name. click out of the textbox. and your new
name 1s saved.

# If you are making multiple versions of your resume or cover letter, be sure to
label each one with a specific title that will help you remember which is which
(such as the title of the job you're applying for).

Once you've completed your basic resume but want to customize it for a particular job
application, make a copy of the resume or cover letter through the "File" menu and
give it a different name. Google Docs automatically saves your new file with your
other docs.

At last save the file by clicking “Make a copy™ or * Down load as”™ or “Email as
attachment™, give file name as Time Table then press “ok™.

Storing and Sharing Your Google Docs Resume or Cover Letter

Once you have created a final version of your resume or cover letter, you'll be able to store it
on Google Does, update it. use it to apply for jobs, and share it with hiring managers and
recruiters.



You can also choose to store it on Google Drive. an organizational system in which you can
create. upload. edit. save. and share documents. Keep m mind that many hiring managers

prefer to receive resumes as attachments in an email or documents uploaded directly to their
corporate job site, rather than shared via link.

If you're applying online. follow the instructions in the job posting. If you're sending your
resume directly to a recruiter or hiring manager. through a networking contact. ask your
connection about the preferred method of delivery.

OUTPUT:

Result:



GRID COMPUTING PROGRAMS USING USE GLOBUS TOOLKIT OR EQUIVALENT

1. Develop a new Web Service for Calculator.

OBJECTIVE:

To develop a new Web service for Calculator applications.

PROCEDURE:

When you start Globus toolkit container, there will be number of services starts up. The service for this
task will be a simple Math service that can perform basic arithmetic for a client.

The Math service will access a resource with two properties:

1. An integer value that can be operated upon by the service

2. A string values that holds string describing the last operation

The service itself will have three remotely accessible operations that operate upon
value:

(a) add, that adds o to the resource property value.

(b) subtract that subtracts a from the resource property value.

(c) getValueRP that returns the current value of value.

Usually, the best way for any programming task is to begin with an overall description of what you want
the code to do, which in this case is the service interface. The service interface describes how what the
service provides in terms of names of operations, their arguments and return values. A Java interface for
our service is:

public interface Math {
public void add(int a);
public void subtract(int a);

public int getValueRP();

}

It is possible to start with this interface and create the necessary WSDL file using the standard Web
service tool called Java2WSDL. However, the WSDL file for GT 4 has to include details of resource

properties that are not given explicitly in the interface above. Hence, we will provide the WSDL file.



Step 1 Getting the Files

All the required files are provided and comes directly from [1]. The MathService source code files can be
found from http://www gt4book.com

(http:/ fwww.gtdbook.com/downloads/gtdbook-examples.tar.gz)
A Windows zip compressed version can be found at

http://www.cs.uncc.edu/~abw/ITC54146507/gt4book-examples.zip. Download and uncompress the file
into a directory called GT4services. Everything is included (the java source WSDL and deployment files,

etc.):

& GT4services
Edit View Favorles Took Help

Qe - ) [T O seweh |

File and Fobder Tasks ! fJ schema gag] | CUSICNORE Fil
| sesf |

9 M 3 resw Folder —

Pubdish this fuider to : -y build fogs buikd
9 the Web I L5 STORE Fil [A | mueemesFs % ML Dicusse
'FJ Share this Folder 1 - i lasE
b globus-build-service 3 namespaceipackage
HFL MAPPINGS File
@ = @] e

Fie

WSDL service interface description file -- The WSDL service interfoce description

file is provided within the GT4services folder at:
51

GT45ervices\schema\examples\MathService_instance\Math.wsdl

This file, and discussion of its contents, can be found in Appendix A. Later on we will need to modify this
file, but first we will use the existing contents that describe the Math service above.

Service code in Java -- For this assignment, both the code for service operations and for the resource
properties are put in the same class for convenience. More complex services and resources would be
defined in separate classes. The Java code for the service and its resource properties is located within
the GT4services folder at:

GTaservices\org\globus\examples\services\core\first\impl\MathService.java.

Deployment Descriptor - The deployment descriptor gives several different important sets of
information about the service once it is deployed. It is located within the GT4services folder at:

GTaservices\org\globus\examples\services\core\first\deploy-server.wsdd.



Step 2 — Building the Math Service

It is now necessary to package all the required files into a GAR (Grid Archive) file. The build tool ant from
the Apache Software Foundation is used to achieve this as shown overleaf:

Generating a GAR file with Ant (from http://gdp.globus.org/gt4-
tutorial/multiplehtml/ch03s04.htmil)
Ant is similar in concept to the Unix make tool but a java tool and XML based.

Build scripts are provided by Globus 4 to use the ant build file. The windows version of the build script
for MathService is the Python file called globus-build-service.py, which held in the GTdservices
directory. The build script takes one argument, the name of your service that you want to deploy. To
keep with the naming convention in [1], this service will be called first.

In the Client Window, run the build script from the GT4services directory with:
globus-build-service.py first
The output should look similar to the following:

Buildfile: build.xml

Creating a Web Service in Java using NetBeans IDE

This document provides step-by-step instructions to create and deploy a web service in Java using
MetBeans IDE and GlassFish 4.0. In the project, we will create a calculation service.

Step 1: Create a Java Web Project
Open NetBeans IDE

Click on New Project and choose Java Web > Web Application

BECH Edit  View Navigate So [ Wa¥ .
2 4 New Project... © 3N Sepe
= i 8§ T3 New File... eN | =Dy
= fue= | &8 Open Project... eso | e —
: - . E e easPare Aepecasion
->

Close AII Projects
Open File...
Open Recent File >

IDE proje

Project Groups...

Import Project
Export Project

vy

Heip e oamz > | Cance:

Page Setup...

Enter the Project Name: CalculationWs, using the default settings and then click on “Finish”™.
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Steps Server and Settings

1. Choose Project

2. Name and Location
3. Server and Settings
4. Frameworks Server:

L

Now the Project has been created.

Step 2: Create a Web Service

Context Path:

Mow go to the Project Tree Structure on the left side of the window.

Right click on the project and select “New” and then choose “Web Service”

Build

Clean and Build
Clean

Verify

Generate |Javadoc

4
g

Run
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Specify web service name “Calws” and package name “Calculationws”. Click on “Finish™.

N am s New Web Service -

Steps Mame and Location

1. Choose File Type o 1
2 ke ol L oxcaohi Web Service Mame: CalWws |

Project: CalculationWws
Location: | Source Packages -
Package: |CalculationWs. -]

(=) Creatve Web Service from Scratch
() Create Web Service from Existing Session Bean

Enterprise Beamn: Browse..

[ Implement Web Service as Stateless Session Bean

Open CalWs.java file, replace the original hello() function with the following code:

@WebMethod(operationName = "Addition")
public String Addition| @WebParam{name = "valuel”) String valuel,@WebParam(name = "value2") String value2

H
float value=Float.valueOf({valuel }+Float.valueOf(value2);
return (Float.toString(value));
!

Mow the web service is created.

Step 3: Deploy and Test Web Servi

Right click on the project and select “Deploy™

* [G& web P Mew >
- Ga \U'Eq
[# indel Build
w [5 Source Clean and Build
v E8 Clean
&= Werify
> [l Libra Generate Javadoc
w & web 5e
» [ ca Run
-
» @ camws Debug
v & Gasstavond  Profile
w [H source Test RESTFul Web Services
» B MET| Test “F&
» B9 weT]
v 5 pass Open Required Projects -
= a Close
= d Rename...
Additian - Navig Mowe.._.
| Members Copy...
> &b cams | Delete Delete
© Addised ping %F
& Subsw Inspect and Transform... o
Wersioning -
History L
Properties.

This is to deploy all the web services in this project. If success, you will see:

23 @WeoMethod{operationMane = “Addltion™)
W B public String Addition(@WebFaraminame = “wvalucl”) String wvaluel,@webParam(name = “"wvaluc2 ] Strimng value2 } {
25 float value=Float.valuedf{valuel)+Float. valvedfivalueZ);
return (Float. toStringivalue) )
13



To test the web service, right click on the service and select “Test Web Service”

Open
Refresh...

Add Operation...

Configure Handlers...

Generate and Copy WSDL...
Generate SOAP-over-HTTP Wrapper
Delete

You will see:

-e. Caraes W Secwmcn Tester -
| 4 iecaroir £080 - Sa s =

CalWsS Web Service Tester

This fioem wil sllow you 30 test your web service Implementation (&SDL Pl
To irrvike an operation. Al e Mmoo pasameme(s} irps boxes A click on the buron labaied with the method name.
Dethods :

Result:

CalWs Web Service Tester

This form will ailow you 30 lest your web service implementation (ASDL Flic)
To invoke an fill S motod inper boxes and click on the buton labeled with the method name.

Methods :
pblc -:-n ,.wmumm‘nn;“un.s-—.mw
asemon .

Right Click on the project and select “Clean and Build”, a war file will be automatically generated under
“dist” sub-directory.



GRID COMPUTING PROGRAMS USING GRIDSIM

GridSim allows modeling and simulation of entities in parallel and distributed computing systems

such as users, applications, resources, and resource brokers/schedulers for design and evaluation

of scheduling algorithms. The resource brokers use scheduling algorithms or policies for mapping

jobs to resources to optimize system or user objectives depending on their goals.

Overview of GridSim functionalities:

Incorporates failures of Grid resources during runtime.

Mew allocation policy can be made and integrated into the GridSim Toolkit, by extending
from AllocPolicy class.

Has the infrastructure or framework to support advance reservation of a grid system.
Incorporates a functionality that reads workload traces taken from supercomputers for
simulating a realistic grid environment.

Incorporates an auction model into GridSim.

Incorporates a data grid extension into GridSim.

Incorporates a network extension into GridSim. Now, resources and other entities can be
linked in a network topology.

Incorporates multiple regional Grid Information Service (GIS) entities connected in a
network topology. Hence, you can simulate an experiment with multiple Virtual
Organizations (VOs).

Adds ant build file to compile GridSim source files.

SOFTWARE REQUIREMENTS:

1. Gridsim Toolkit
2. JDK (java development kit) new version.
3. Eclipse for java developers.

Installation steps:

1.Install JDK toolkit

2.Set path for JDK toolkit Path=C:/jdk1.8/binClasspath=C:/jdk1.8/jre/lib/rt.jar;

3.Download GridSim 5.2

4.Extract GridSim into one folder.

5.Set path = C:/gridsim/bin;

6.SetClasspath = C:/gridsim/jar/*;

7.Set Classpath = C:/gridsim/examples;

8.Set variable GridSim=C:/gridsim



1. Program to creates one Grid resource with three machines.

Aim: To creates one Grid resource with three machines.

Description:

GridSim creates modelling and scheduling. The speciality of gridsim tool kit is that it includes the
network buffer management policies which cannot be simulated in Optorsim, Microsim etc. Grid
computing having the high variable environment. The grid resource is very important in gridsim and it
is flexibility to implement various scheduling algorithms.

User — Each instance of the User entity represents a Grid user. Each user may differ from the rest of

users .
Source code:

package gridsim.example®l;

import java.
import java.

util.Calendar;
util.LinkedList;

import gridsim.*;

class Examplel

{

@SuppressWarnings ("unused")
public static void main(String[] args)

{

System.out.println("Starting example of how to create one Grid " +

try
{

"resource");

int num_user = 0;
Calendar calendar = Calendar.getInstance();
boolean trace_flag = true; // mean trace GridSim events/activities

// list of files or processing names to be excluded from any
//statistical measures

String[] exclude_from_file = { "" };

String[] exclude_from processing = { "" };

String report_name = null;

// Initialize the GridSim package

System.out.println("Initializing GridSim package");

GridSim.init(num_user, calendar, trace_flag, exclude_from_file,
exclude_from_processing, report_name);

// Second step: Create one Grid resource
GridResource gridResource = createGridResource();
System.out.println("Finish the 1st example");



}

catch (Exception e)

{
e.printStackTrace();
System.out.println("Unwanted error happens");

@SuppressWarnings("deprecation™)
private static GridResource createGridResource()
{
System.out.println("Starting to create one Grid resource with " +
"3 Machines ...");

MachinelList mList = new MachinelList();
System.out.println("Creates a Machine list");

int mipsRating = 377;

mList.add( new Machine(®, 4, mipsRating)); // First Machine

System.out.println("Creates the 1st Machine that has 4 PEs and " +
"stores it into the Machine 1list");

mList.add( new Machine(1, 4, mipsRating)); // Second Machine
System.out.println("Creates the 2nd Machine that has 4 PEs and " +
"stores it into the Machine 1list");

mList.add( new Machine(2, 2, mipsRating)); // Third Machine
System.out.println("Creates the 3rd Machine that has 2 PEs and " +
"stores it into the Machine list");

String arch = "Sun Ultra"; // system architecture

String os = "Solaris"; // operating system

double time_zone = 9.0; // time zone this resource located
double cost = 3.9; // the cost of using this resource

ResourceCharacteristics resConfig = new ResourceCharacteristics(
arch, os, mList, ResourceCharacteristics.TIME_SHARED,
time_zone, cost);

System.out.println();
System.out.println("Creates the properties of a Grid resource and " +
"stores the Machine list");

// 5. Finally, we need to create a GridResource object.
String name = "Resource_0"; // resource name
double baud_rate = 100.0; // communication speed
long seed = 11L*13%17*19*23+1;

double peakLoad = 0.0;
double offPeakLoad = O.
double holidaylLoad = 0.

// the resource load during peak hour
0; // the resource load during off-peak hr
0; // the resource load during holiday



// incorporates weekends so the grid resource is on 7 days a week
LinkedList<Integer> Weekends = new LinkedList<Integer>();
Weekends.add(new Integer(Calendar.SATURDAY));

Weekends.add(new Integer(Calendar.SUNDAY));

// incorporates holidays. However, no holidays are set in this example
LinkedList<Integer> Holidays = new LinkedList<Integer>();

GridResource gridRes = null;

try

{
gridRes = new GridResource(name, baud_rate, seed,resConfig, peaklLoad, offPeakLoad,
holidaylLoad, Weekends, Holidays);

}

catch (Exception e) {

e.printStackTrace();

}

System.out.println("Finally, creates one Grid resource and stores
"the properties of a Grid resource");

+

return gridRes;

Output:

Starting example of how to create one Grid resocurce

Initializing GridSim package

Initialising...

Starting to create one Grid resource with 3 Machines

Creates a Machine list

Creates the 1st Machine that has 4 PEs and stores it into the Machine list
Creates the 2Znd Machine that has 4 PEs and stores it into the Machine list
Creates the 3rd Machine that has 2 PEs and stores it into the Machine list

Creates the properties of a Grid rescurce and stores the Machine list
Finally, creates one Grid resource and stores the properties of a Grid resource
Finish the lst example

2. Program to create one or more Grid users. A Grid user contains one or more Gridlets.

Aim: To create a java program one or more Grid users and it contains one or more Gridlets.

Description:

The grid systems may have their own grid login ID separate from the one on the operating system. A grid
login is usually more convenient for grid users.

It eliminates the ID matching problems among different machines. To the user, it makes the grid look
more like one large virtual computer rather than a collection of individual machines.

User — Each instance of the User entity represents a Grid user. Each user may differ from the rest of
users .



Source code:
package gridsim.example01;

import java.util.*;
import gridsim.*;

class Example2

{

public static void main(String[] args)

{
System.out.printIn("Starting example of how to create Grid users");
System.out.printin();

try

{
// Creates a list of Gridlets
GridletList list = createGridlet();
System.out.printIn("Creating " + list.size() + " Gridlets");

ResourceUserList userlList = createGridUser(list);
System.out.printIn("Creating " + userList.size() + " Grid users");

// print the Gridlets
printGridletList(list);

System.out.printIn("Finish the example");

}

catch (Exception e)

{
e.printStackTrace();

System.out.printIn("Unwanted error happens");

private static GridletList createGridlet()
{

// Creates a container to store Gridlets
GridletList list = new GridletList();

// We create three Gridlets or jobs/tasks manually without the help



// of GridSimRandom

intid=0;

double length = 3500.0;

long file_size = 300;

long output_size = 300;

Gridlet gridletl = new Gridlet(id, length, file_size, output_size);
id++;

Gridlet gridlet2 = new Gridlet(id, 5000, 500, 500);

id++;

Gridlet gridlet3 = new Gridlet(id, 9000, 900, 900);

// Store the Gridlets into a list
list.add(gridletl);
list.add(gridlet2);
list.add(gridlet3);

// We create 5 Gridlets with the help of GridSimRandom and
// GriSimStandardPE class
Random random = new Random();

// sets the PE MIPS Rating
GridSimStandardPE.setRating(100);

// creates 5 Gridlets

int count =5;

double min_range = 0.10;
double max_range = 0.50;
for (inti=1;i<count+l; i++)

{

length = GridSimStandardPE.toMIs(random.nextDouble()*output_size);

file_size = (long) GridSimRandom.real(100, min_range, max_range,
random.nextDouble());

output_size = (long) GridSimRandom.real(250, min_range, max_range,
random.nextDouble());

// creates a new Gridlet object
Gridlet gridlet = new Gridlet(id + i, length, file_size,
output_size);



{

// add the Gridlet into a list
list.add(gridlet);

return list;

private static ResourceUserList createGridUser(GridletList list)
ResourceUserlList userList = new ResourceUserList();

userlist.add(0); // user ID starts from O
userlist.add(1);
userlist.add(2);

int userSize = userlList.size();
int gridletSize = list.size();
intid =0;

// assign user ID to particular Gridlets
for (inti=0; i< gridletSize; i++)
{
if (i I= 0 && i % userSize == 0)
id++;

( (Gridlet) list.get(i) ).setUserID(id);

return userList;

private static void printGridletList(GridletList list)

{

int size = list.size();
Gridlet gridlet;
String indent="";
System.out.printin();
System.out.printin("Gridlet ID" + indent + "User ID" + indent +
"length" + indent + " file size" + indent +
"output size");



for (inti=0;i<size; i++)
{
gridlet = (Gridlet) list.get(i);
System.out.printIn(indent + gridlet.getGridletID() + indent +
indent + indent + gridlet.getUserID() + indent + indent +
(int) gridlet.getGridletLength() + indent + indent +
(int) gridlet.getGridletFileSize() + indent + indent +
(int) gridlet.getGridletOutputSize() );

}
}// end class

Output:

Starting example of how to create Grid users

Creating 8 Gridlets
Creating 3 Grid users

Gridlet ID User ID length file size cutput size
] ] ISee See e
1 @ Saea Saa SEa
2 @ Saaa Saa Sea
= 1 15759 12 233
4 1 14@E3 131 @z
= 1 Fa3a 92 I3
=1 2 4829 1=8 289
7 2 1774 1el 241
Finish the example

3. Program to shows how two GridSim entities interact with each other ; main(ie example3)
class creates Gridlets and sends them to the other GridSim entities, i.e. Test class

Aim: To create a java program how two GridSim entities interact with each other.
Description:

An instance of this class simulates a collection of machines. It is up to the GridSim users to define the
connectivity among the machines in a collection.

The process of creating a Grid resource is as follows: first create PE objects with a suitable MIPS rating,
second assemble them together to create a Machine and finally group multiple Machine objects
together to form a resource. A resource having a single machine with one or more PEs is managed as
time-shared system using round robin scheduling algorithm.

Source code:

package gridsim.example®3;
import java.util.*;
import gridsim.*;
class Example3 extends GridSim
{
private String entityName_;
private GridletList list_;

// Gridlet lists received from Test object
private GridletList receivelist_;
Example3(String name, double baud rate, GridletList list) throws Exception



super(name);
this.list_ = list;
receivelList_ = new GridletList();

// creates a Test entity, and refer it as "entityName"

entityName_ = "Test";
new Test(entityName_, baud_rate);

public void body()

{
int size = list_.size();
Gridlet obj, gridlet;
// a loop to get one Gridlet at one time and sends it to other GridSim
// entity
for (int i = @; i < size; i++)
{
obj = (Gridlet) list_.get(i);
System.out.println("Inside Example3.body() => Sending Gridlet " +
obj.getGridletID());
super.send(entityName_, GridSimTags.SCHEDULE_NOW,
GridSimTags.GRIDLET_SUBMIT, obj);
// Receiving a Gridlet back
gridlet = super.gridletReceive();
System.out.println("Inside Example3.body() => Receiving Gridlet "+
gridlet.getGridletID());
// stores the received Gridlet into a new GridletlList object
receivelist_.add(gridlet);
}
// Signals the end of simulation to "entityName"
super.send(entityName_, GridSimTags.SCHEDULE_NOW,
GridSimTags.END_OF_SIMULATION);
}

public GridletList getGridletList() {
return receivelist_;

}

public static void main(String[] args)

{
System.out.println("Starting Example3");

System.out.println();

try
{

int num_user = 0; // number of users need to be created
Calendar calendar = Calendar.getInstance();
boolean trace_flag = true; // mean trace GridSim events



String[] exclude_from_file = { "" };
String[] exclude_from_processing = { "" };

String report_name = null;

// Initialize the GridSim package

System.out.println("Initializing GridSim package");

GridSim.init(num_user, calendar, trace_flag, exclude_from_file,
exclude_from_processing, report_name);

// Second step: Creates a list of Gridlets
GridletList list = createGridlet();
System.out.println("Creating " + list.size() + " Gridlets");

// Third step: Creates the Example3 object
Example3 obj = new Example3("Example3", 560.00, list);

// Fourth step: Starts the simulation
GridSim.startGridSimulation();

// Final step: Prints the Gridlets when simulation is over
GridletList newlList = obj.getGridletList();
printGridletList(newlList);

System.out.println("Finish Example3");

}
catch (Exception e)
{
e.printStackTrace();
System.out.println("Unwanted errors happen");
}

private static GridletList createGridlet()

{
// Creates a container to store Gridlets
GridletList list = new GridletList();

int id = 0;

double length = 3500.0;

long file_size = 300;

long output_size = 300;

Gridlet gridletl = new Gridlet(id, length, file size, output_size);
id++;

Gridlet gridlet2
id++;

Gridlet gridlet3 = new Gridlet(id, 9000, 900, 900);

new Gridlet(id, 5000, 500, 500);

// Store the Gridlets into a list
list.add(gridletl);



list.add(gridlet2);
list.add(gridlet3);

long seed = 11L*13*17%19*23+1;
Random random = new Random(seed);

GridSimStandardPE.setRating(100);

// creates 5 Gridlets
int count = 5;
for (int i = 1; i < count+l; i++)

{

length = GridSimStandardPE.toMIs(random.nextDouble()*50);

file _size = (long) GridSimRandom.real(100, ©.10, 0.40,
random.nextDouble());

output_size = (long) GridSimRandom.real (250, ©.10, 0.50,
random.nextDouble());

// creates a new Gridlet object
Gridlet gridlet = new Gridlet(id + i, length, file_ size,
output_size);

// add the Gridlet into a 1list
list.add(gridlet);
}

return list;

private static void printGridletList(GridletList list)

{

int size = list.size();

Gridlet gridlet;

String indent = " "5

System.out.println();

System.out.println("========== QUTPUT ==========");
System.out.println("Gridlet ID" + indent + "STATUS");

for (int i = @; i < size; i++)

{
gridlet = (Gridlet) list.get(i);
System.out.print(indent + gridlet.getGridletID() + indent
+ indent);
if (gridlet.getGridletStatus() == Gridlet.SUCCESS)
System.out.println("SUCCESS");
}



Test.java:

package gridsim.example@3;
import java.util.*;

import gridsim.*;

import eduni.simjava.Sim_event;

class Test extends GridSim

{
Test(String name, double baud_rate) throws Exception
{
super(name, baud_rate);
System.out.println("... Creating a new Test object");
}

public void body()

{
int entityID;
Sim_event ev = new Sim_event();
Gridlet gridlet;
// Gets one event at a time
for ( sim_get_next(ev); ev.get_tag() != GridSimTags.END_OF_SIMULATION;
sim_get next(ev) )
{
// Gets the Gridlet object sent by Example3 class
gridlet = (Gridlet) ev.get_data();
// Change the Gridlet status, meaning that the Gridlet has been
// received successfully
try {
gridlet.setGridletStatus(Gridlet.SUCCESS);
}
catch (Exception e) {
e.printStackTrace();
}
System.out.println("... Inside Test.body() => Receiving Gridlet "+
gridlet.getGridletID() + " from Example3 object");
// get the sender ID, i.e Example3 class
entityID = ev.get_src();
// sends back the modified Gridlet to the sender
super.send(entityID, GridSimTags.SCHEDULE_NOW,
GridSimTags.GRIDLET_RETURN, gridlet);
}
// when simulation ends, terminate the Input and Output entities
super.terminateIOEntities();
}



Output:
Starting Example3

Initializing GridSim package
Initialising...
Creating 8 Gridlets
. Creating a new Test object
Starting GridSim version 5.8
Entities started.
Inside Example3.body() => Sending Gridlet @
GridInformationService: Notify all GridSim entities for shutting down.
. Inside Test.body() =» Receiving Gridlet @ from Example3 cbject
Inside Example3.body() =» Receiving Gridlet @
Inside Example3.body() =» Sending Gridlet 1
. Inside Test.body() =* Receiving Gridlet 1 from Example3 cbject
Inside Example3.body() =* Receiving Gridlet 1
Inside Example3.body() =* Sending Gridlet 2
. Inside Test.body() => Receiving Gridlet 2 from Example3 object
Inside Example3.body() =» Receiving Gridlet 2
Inside Example3.body() =* Sending Gridlet 3
. Inside Test.body() =» Receiving Gridlet 3 from Example3 cbject
Inside Example3.body() =» Receiving Gridlet 3
Inside Example3.body() =p Sending Gridlet 4
. Inside Test.body() =» Receiving Gridlet 4 from Example3 cbject
Inside Example3.body() =* Receiving Gridlet 4
Inside Example3.body() =» Sending Gridlet 5
. Inside Test.body() =» Receiving Gridlet 5 from Example3 cbject
Inside Example3.body() =* Receiving Gridlet 5
Inside Example3.body() =» Sending Gridlet &
. Inside Test.body() =» Receiving Gridlet & from Example3 cbject
Inside Example3.body() =* Receiving Gridlet &
Inside Example3.body() =» Sending Gridlet 7
. Inside Test.body() =»> Receiving Gridlet 7 from Example3 object
Inside Example3.body() =» Receiving Gridlet 7
Sim_system: No more future ewvents
Gathering simulation data.
Simulation completed.

========== (QUTPUT ==========
Gridlet ID STATUS
SUCCESS
SUCCESS
SUCCESS
SUCCESS
SUCCESS
SUCCESS
SUCCESS
SUCCESS
Finish Example3

L. Y, - TTRN CRS.



4. Program shows how a grid user submits its Gridlets or tasks to one gridresource entity.

Aim: To create a java program how a grid user submits its Gridlets or tasks to one gridresource
entity.

Description:

An instance of this class represents one Grid-enabled task. Individual users create tasks that are
processed by Grid resources through resource brokers that implement various scheduling policies.

An instance of this class represents an experiment that consists of a GridletList and an optimization
policy. On receiving an experiment form its user, a resource broker starts scheduling individual Gridlets
according to the optimization policy set for the experiment.

Source code:

package gridsim.example01;
import java.util.*;

import gridsim.*;

// creates Gridlets and sends them to a grid resource entity

class Example4 extends GridSim
{
private Integer ID_;
private String name_;
private GridletList list_;
private GridletList receivelist_;
Example4(String name, double baud_rate) throws Exception
{
super(name, baud_rate);
this.name_ = name;
this.receivelist_ = new GridletList();

// Gets an ID for this entity

this.ID_ = new Integer( getEntityld(name) );

System.out.printIn("Creating a grid user entity with name =" +
name +", and id =" + this.ID_);

// Creates a list of Gridlets or Tasks for this grid user
this.list_ = createGridlet( this.ID_.intValue() );
System.out.printin("Creating " + this.list_.size() + " Gridlets");

}

public void body()

{

int resourcelD =0;



String resourceName;
LinkedList resList;
ResourceCharacteristics resChar;

while (true)

{

super.gridSimHold(1.0); // hold by 1 second
resList = super.getGridResourcelList();
if (resList.size() > 0)

{

Integer num = (Integer) resList.get(0);
resourcelD = num.intValue();

// Requests to resource entity to send its characteristics
super.send(resourcelD, GridSimTags.SCHEDULE_NOW,
GridSimTags.RESOURCE_CHARACTERISTICS, this.ID_);

// waiting to get a resource characteristics
resChar = (ResourceCharacteristics) super.receiveEventObject();
resourceName = resChar.getResourceName();

System.out.printIn("Received ResourceCharacteristics from " +
resourceName + ", with id =" + resourcelD);

// record this event into "stat.txt" file
super.recordStatistics("\"Received ResourceCharacteristics " +
"from " + resourceName + "\"", "");

break;

}

else
System.out.printin("Waiting to get list of resources ...");

Gridlet gridlet;
String info;

for (inti=0; i< this.list_.size(); i++)

{
gridlet = (Gridlet) this.list_.get(i);



info = "Gridlet_" + gridlet.getGridletID();

System.out.printIn("Sending " + info + " to " + resourceName +
"with id =" + resourcelD);

// Sends one Gridlet to a grid resource specified in "resourcelD"
super.gridletSubmit(gridlet, resourcelD);

super.recordStatistics("\"Submit " + info + " to " + resourceName +

"\,

// waiting to receive a Gridlet back from resource entity
gridlet = super.gridletReceive();
System.out.printin("Receiving Gridlet " + gridlet.getGridletID());

// Recods this event into "GridSim_stat.txt" file for statistical

// purposes

super.recordStatistics("\"Received " + info + " from " +
resourceName + "\"", gridlet.getProcessingCost());

// stores the received Gridlet into a new GridletList object
this.receivelist_.add(gridlet);

// shut down all the entities, including GridStatistics entity since
// we used it to record certain events.
super.shutdownGridStatisticsEntity();
super.shutdownUserEntity();

super.terminatelOEntities();

public GridletList getGridletList() {
return this.receivelist_;

private GridletList createGridlet(int userID)
{

// Creates a container to store Gridlets
GridletList list = new GridletList();

intid =0;



double length = 3500.0;

long file_size = 300;

long output_size = 300;

Gridlet gridletl = new Gridlet(id, length, file_size, output_size);
id++;

Gridlet gridlet2 = new Gridlet(id, 5000, 500, 500);

id++;

Gridlet gridlet3 = new Gridlet(id, 9000, 900, 900);

// setting the owner of these Gridlets
gridletl.setUserID(userlD);
gridlet2.setUserID(userlD);
gridlet3.setUserID(userlD);

// Store the Gridlets into a list
list.add(gridletl);
list.add(gridlet2);
list.add(gridlet3);

// We create 5 Gridlets with the help of GridSimRandom and
// GriSimStandardPE class

long seed = 11L*13*17*19*23+1;

Random random = new Random(seed);

// sets the PE MIPS Rating
GridSimStandardPE.setRating(100);

// creates 5 Gridlets

int count = 5;

for (inti=1;i<count+l; i++)

{
// the Gridlet length determines from random values and the
// current MIPS Rating for a PE
length = GridSimStandardPE.toMls(random.nextDouble()*50);

// determines the Gridlet file size that varies within the range

// 100 + (10% to 40%)

file_size = (long) GridSimRandom.real(100, 0.10, 0.40,
random.nextDouble());

// determines the Gridlet output size that varies within the range

// 250 + (10% to 50%)

output_size = (long) GridSimRandom.real(250, 0.10, 0.50,
random.nextDouble());



// creates a new Gridlet object
Gridlet gridlet = new Gridlet(id + i, length, file_size,
output_size);

gridlet.setUserID(userlID);

// add the Gridlet into a list
list.add(gridlet);

return list;

[T STATIC METHODS ///111111111117111111117

/**
* Creates main() to run this example
*
/
public static void main(String[] args)

{
System.out.printIn("Starting Example4");

try
{

int num_user =1; // number of grid users
Calendar calendar = Calendar.getinstance();
boolean trace_flag = true; // mean trace GridSim events

String[] exclude_from_file={""};
String[] exclude_from_processing={"" };

String report_name = null;

System.out.printin("Initializing GridSim package");
GridSim.init(num_user, calendar, trace_flag, exclude_from_file,
exclude_from_processing, report_name);



String name = "Resource_0";
GridResource resource = createGridResource(name);

Example4 obj = new Example4("Example4", 560.00);

GridSim.startGridSimulation();

// Final step: Prints the Gridlets when simulation is over
GridletList newList = obj.getGridletList();
printGridletList(newList);

System.out.printIn("Finish Example4");

}

catch (Exception e)

{
e.printStackTrace();
System.out.printIn("Unwanted errors happen");

private static GridResource createGridResource(String name)
{
System.out.printin();
System.out.printIn("Starting to create one Grid resource with " +
"3 Machines");

MachinelList mList = new MachinelList();
System.out.printin("Creates a Machine list");

int mipsRating = 377,

mList.add( new Machine(0, 4, mipsRating)); // First Machine

System.out.printIn("Creates the 1st Machine that has 4 PEs and " +
"stores it into the Machine list");

mList.add( new Machine(1, 4, mipsRating)); // Second Machine
System.out.printIn("Creates the 2nd Machine that has 4 PEs and " +
"stores it into the Machine list");



mList.add( new Machine(2, 2, mipsRating)); // Third Machine
System.out.printIn("Creates the 3rd Machine that has 2 PEsand " +
"stores it into the Machine list");

String arch = "Sun Ultra";  // system architecture

String os = "Solaris"; // operating system

double time_zone =9.0; // time zone this resource located
double cost = 3.0; // the cost of using this resource

ResourceCharacteristics resConfig = new ResourceCharacteristics(
arch, os, mList, ResourceCharacteristics. TIME_SHARED,
time_zone, cost);

System.out.printIn("Creates the properties of a Grid resource and " +
"stores the Machine list");

// 5. Finally, we need to create a GridResource object.

double baud_rate = 100.0; // communication speed

long seed = 11L*13*17*19*23+1;

double peakLoad = 0.0; // the resource load during peak hour
double offPeakLoad = 0.0; // the resource load during off-peak hr
double holidayLoad =0.0; // the resource load during holiday

// incorporates weekends so the grid resource is on 7 days a week
LinkedList Weekends = new LinkedList();

Weekends.add(new Integer(Calendar.SATURDAY));
Weekends.add(new Integer(Calendar.SUNDAY));

// incorporates holidays. However, no holidays are set in this example
LinkedList Holidays = new LinkedList();
GridResource gridRes = null;
try
{
gridRes = new GridResource(name, baud_rate, seed,
resConfig, peakLoad, offPeakLoad, holidayLoad, Weekends,
Holidays);
}
catch (Exception e) {
e.printStackTrace();

System.out.printin("Finally, creates one Grid resource and stores " +
"the properties of a Grid resource");



System.out.printin();

return gridRes;

private static void printGridletList(GridletList list)

int size = list.size();

Gridlet gridlet;

String indent="";

System.out.printin();

System.out.printin("========== OQUTPUT =========="),

System.out.printin("Gridlet ID" + indent + "STATUS" + indent +
"Resource ID" + indent + "Cost");

for (inti=0; i< size; i++)
{
gridlet = (Gridlet) list.get(i);
System.out.print(indent + gridlet.getGridletID() + indent
+ indent);

if (gridlet.getGridletStatus() == Gridlet.SUCCESS)
System.out.print("SUCCESS");

System.out.printin( indent + indent + gridlet.getResourcelD() +
indent + indent + gridlet.getProcessingCost() );

Output:



Starting Gridsim version 5.8
Entities started.

Received ResourceCharacteristics from Resource_8, with id = 5
Sending Gridlet ® to Resource_@ with id = 5

Receiving Gridlet @

Sending Gridlet 1 to Resource @& with id
Receiving Gridlet 1

Sending Gridlet_2 to Resource_@ with id = 5

Receiving Gridlet 2

Sending G@ridlet_3 to Resource_ @ with id = 5

Receiving Gridlet 3

Sending Gridlet_4 to Resource_@ with id = 5

Receiving Gridlet 4

Sending Gridlet 5 to Resource @ with id = 5

Receiving Gridlet 5

Sending Gridlet & to Resource_@ with id = 5

Receiving Gridlet 6

Sending G@ridlet 7 to Resource @ with id = 5

Receiving Gridlet 7

GridInformationService: Notify all GridSim entities for shutting down.
Sim_system: No more future events

Gathering simulaticn data.

Simulation completed.

1]
(%3]

========== JUJTPUT ==========

Gridlet ID STATUS Resource ID Cost
=] SUCCESS 5 27.851458885941646
1 SUCCESS 5 39.,78779848548887
2 SUCCESS 5 71.6188371352786
3 SUCCESS 5 12.2681859252868578
4 SUCCESS 5 32.16888397R344375
5 SUCCESS 5 26.989166622345886
B SUCCESS 5 16.721823985496365
7 SUCCESS 5 28.974565689486667

Finish Examples4

5. Program to show how a grid user submits its Grid lets or task to many grid resource entities.
Aim: To create a java program how a grid user submits its Grid lets or task to many grid
resource entities.

Description:

An instance of this class simulates a machine with one or more CPUs. A Machine object can model both
uniprocessor and multiprocessor. class gridsim.MachineList — An instance of this class simulates a
collection of machines. It is up to the GridSim users to define the connectivity among the machines in a
collection.

An instance of this class represents all static properties of a Resource such as resource architecture, OS,
management policy (time or space shared), cost, and time zone at which resource is located.

Source code:
package gridsim.example01;

import java.util.*;
import gridsim.*;



//class creates Gridlets and sends them to many grid resource

class Example5 extends GridSim
{
private Integer ID_;
private String name_;
private GridletList list_;
private GridletList receivelist_;
private int totalResource_;

Example5(String name, double baud_rate, int total_resource)
throws Exception

super(name, baud_rate);
this.name_ = name;
this.totalResource_ = total_resource;
this.receivelist_ = new GridletList();

// Gets an ID for this entity

this.ID_ = new Integer( getEntityld(name) );

System.out.printIn("Creating a grid user entity with name ="+
name +",and id =" + this.ID_);

// Creates a list of Gridlets or Tasks for this grid user
this.list_ = createGridlet( this.ID_.intValue() );
System.out.printin("Creating " + this.list_.size() + " Gridlets");

/**

* The core method that handles communications among GridSim entities
*/

public void body()

{

int resourcelD[] = new int[this.totalResource_];
double resourceCost[] = new double[this.totalResource_];
String resourceName[] = new String[this.totalResource_];

LinkedList resList;
ResourceCharacteristics resChar;

while (true)



super.gridSimHold(1.0); // hold by 1 second

resList = super.getGridResourcelList();
if (resList.size() == this.totalResource_)
break;
else
System.out.printIn("Waiting to get list of resources ...");

inti=0;

for (i = 0; i < this.totalResource_; i++)

{

resourcelD[i] = ( (Integer)resList.get(i) ).intValue();

super.send(resourcelD[i], GridSimTags.SCHEDULE_NOW,
GridSimTags.RESOURCE_CHARACTERISTICS, this.ID_);

resChar = (ResourceCharacteristics) super.receiveEventObject();
resourceNameli] = resChar.getResourceName();
resourceCost[i] = resChar.getCostPerSec();

System.out.printin("Received ResourceCharacteristics from " +
resourceNamel[i] + ", with id =" + resourcelD[i]);

// record this event into "stat.txt" file
super.recordStatistics("\"Received ResourceCharacteristics " +

")

"from " + resourceName[i] + "\"",

Gridlet gridlet;
String info;

// aloop to get one Gridlet at one time and sends it to a random grid
Random random = new Random();

intid =0;

for (i = 0; i < this.list_.size(); i++)

{



gridlet = (Gridlet) this.list_.get(i);
info = "Gridlet_" + gridlet.getGridletID();

id = random.nextlInt(this.totalResource_);
System.out.printIn("Sending " + info + " to " + resourceName[id] +
"with id =" + resourcelD[id]);

// Sends one Gridlet to a grid resource specified in "resourcelD"
super.gridletSubmit(gridlet, resourcelD[id]);
super.recordStatistics("\"Submit " + info+ " to " +
resourceNamel[id] + "\"", "");

gridlet = super.gridletReceive();
System.out.printin("Receiving Gridlet " + gridlet.getGridletID());

super.recordStatistics("\"Received " + info + " from " +
resourceNamelid] + "\"", gridlet.getProcessingCost());

this.receivelist_.add(gridlet);

super.shutdownGridStatisticsEntity();
super.shutdownUserEntity();
super.terminatelOEntities();

public GridletList getGridletList() {
return this.receivelist_;

private GridletList createGridlet(int userID)
{

GridletList list = new GridletList();

intid=0;

double length = 3500.0;
long file_size = 300;
long output_size = 300;



Gridlet gridletl = new Gridlet(id, length, file_size, output_size);
id++;

Gridlet gridlet2 = new Gridlet(id, 5000, 500, 500);

id++;

Gridlet gridlet3 = new Gridlet(id, 9000, 900, 900);

// setting the owner of these Gridlets
gridletl.setUserID(userlD);
gridlet2.setUserID(userID);
gridlet3.setUserID(userlD);

// Store the Gridlets into a list
list.add(gridletl);
list.add(gridlet2);
list.add(gridlet3);

long seed = 11L*13*17*19*23+1;
Random random = new Random(seed);

// sets the PE MIPS Rating
GridSimStandardPE.setRating(100);

// creates 5 Gridlets
int count =5;
for (inti=1;i<count+l; i++)

{

length = GridSimStandardPE.toMIs(random.nextDouble()*50);

file_size = (long) GridSimRandom.real(100, 0.10, 0.40,

random.nextDouble());

output_size = (long) GridSimRandom.real(250, 0.10, 0.50,
random.nextDouble());

// creates a new Gridlet object
Gridlet gridlet = new Gridlet(id + i, length, file_size,
output_size);

gridlet.setUserID(userID);

// add the Gridlet into a list



list.add(gridlet);

return list;

/111111111111111111111111] STATIC METHODS ////1/1111111111111111/

/**
* Creates main() to run this example
*
/
public static void main(String[] args)

{
System.out.printIn("Starting Example5");

try
{

int num_user =1; // number of grid users
Calendar calendar = Calendar.getInstance();
boolean trace_flag = false; // mean don't trace GridSim events

String[] exclude_from_file ={""};
String[] exclude_from_processing ={"" };

String report_name = null;

System.out.printin("Initializing GridSim package");
GridSim.init(num_user, calendar, trace_flag, exclude_from_file,
exclude_from_processing, report_name);

GridResource resource0 = createGridResource("Resource_0");
GridResource resourcel = createGridResource("Resource_1");
GridResource resource2 = createGridResource("Resource_2");
int total_resource = 3;

// Third step: Creates the Example5 object
Example5 obj = new Example5("Example5", 560.00, total_resource);

// Fourth step: Starts the simulation
GridSim.startGridSimulation();

// Final step: Prints the Gridlets when simulation is over



GridletList newList = obj.getGridletList();
printGridletList(newList);

System.out.printIn("Finish Example5");

}

catch (Exception e)

{
e.printStackTrace();
System.out.printIn("Unwanted errors happen");

private static GridResource createGridResource(String name)
{
System.out.printin();
System.out.printIn("Starting to create one Grid resource with " +
"3 Machines");

MachinelList mList = new MachineList();
System.out.printIn("Creates a Machine list");

int mipsRating = 377,

mList.add( new Machine(0, 4, mipsRating)); // First Machine

System.out.printIn("Creates the 1st Machine that has 4 PEs and " +
"stores it into the Machine list");

mList.add( new Machine(1, 4, mipsRating)); // Second Machine
System.out.printin("Creates the 2nd Machine that has 4 PEs and " +
"stores it into the Machine list");

mList.add( new Machine(2, 2, mipsRating)); // Third Machine
System.out.printIn("Creates the 3rd Machine that has 2 PEsand " +
"stores it into the Machine list");

String arch = "Sun Ultra";  // system architecture

String os = "Solaris"; // operating system

double time_zone =9.0; // time zone this resource located
double cost = 3.0; // the cost of using this resource



ResourceCharacteristics resConfig = new ResourceCharacteristics(
arch, os, mList, ResourceCharacteristics. TIME_SHARED,
time_zone, cost);

System.out.printIn("Creates the properties of a Grid resource and " +
"stores the Machine list");

// 5. Finally, we need to create a GridResource object.

double baud_rate = 100.0; // communication speed

long seed = 11L*13*17*19*23+1;

double peakLoad =0.0;  // the resource load during peak hour
double offPeakLoad = 0.0; // the resource load during off-peak hr
double holidayLoad =0.0; // the resource load during holiday

// incorporates weekends so the grid resource is on 7 days a week
LinkedList Weekends = new LinkedList();

Weekends.add(new Integer(Calendar.SATURDAY));
Weekends.add(new Integer(Calendar.SUNDAY));

// incorporates holidays. However, no holidays are set in this example
LinkedList Holidays = new LinkedList();
GridResource gridRes = null;
try
{
gridRes = new GridResource(name, baud_rate, seed,
resConfig, peakLoad, offPeakLoad, holidayLoad, Weekends,
Holidays);
}
catch (Exception e) {
e.printStackTrace();

System.out.printIn("Finally, creates one Grid resource and stores " +
"the properties of a Grid resource");
System.out.printin();

return gridRes;

private static void printGridletList(GridletList list)
{

int size = list.size();
Gridlet gridlet;



String indent="";

System.out.printin();

System.out.printin("========== QUTPUT =========="),

System.out.printin("Gridlet ID" + indent + "STATUS" + indent +
"Resource ID" + indent + "Cost");

for (inti=0;i<size; i++)
{
gridlet = (Gridlet) list.get(i);
System.out.print(indent + gridlet.getGridletID() + indent
+indent);

if (gridlet.getGridletStatus() == Gridlet.SUCCESS)
System.out.print("SUCCESS");

System.out.printIn( indent + indent + gridlet.getResourcelD() +
indent + indent + gridlet.getProcessingCost() );

}// end class

Output:

Starting ExampleS
Initializing GridSim package
Initialising...

Starting to create one Grid resource with 3 Machines

Creates a Machine list

Creates the 1st Machine that has 4 PEs and stores it inte the Machine list
Creates the 2nd Machine that has 4 PEs and stores it into the Machine list
Creates the 3rd Machine that has 2 PEs and stores it into the Machine list
Creates the properties of a Grid rescurce and stores the Machine list

Finally, creates one Grid resource and stores the properties of a Grid resource



Creating a grid user entity with name = ExampleS, and id = 17
Creating 8 Gridlets

Starting Gridsim wversion S.8

Entities started.

Waiting to get list of rescurces

Waiting to get list of rescurces

Receiwved RescurceCharacteristics from Rescource @, with id = S
Receiwved RescurceCharacteristics from Rescurce_2, with id = 13
Receiwved RescurceCharacteristics from Resocurce 1, with id = 9
Sending Gridlet_& to Resource_1 with id = 9

Receiwving Gridlet &

sending Gridlet_1 to Rescurce_1 with id = 9

Receiwving Gridlet 1L

Sending Gridlet_2 to Rescource_1 with id = 9

Receiwving Gridlet 2

Sending Gridlet_3 to Rescource_@ with id = 5

Receiwing Gridlet 3

sending Gridlet_<4 to Rescurce_1 with id = 9

Receiwving Gridlet 4

Sending Gridlet_ 5 to Rescource_@ with id = 5

Receiwving Gridlet S

Sending Gridlet_6 to Resource_2 with id = 13

Receiwing Gridlet &

sending Gridlet 7 to Rescource_2 with id = 13

Receiving Gridlet 7

GridInformationSerwvice: Motify all GridSim entities for shutting down.
Sim_system: Mo more future events

Gathering simulation data.
Simulation completed.

========== 0OUTPUT ==========

Gridlet ID STATUS Rescurce ID Cost
=] S CESS = 27 .851458885941646
a1 SIMCCESS =] I9.7eF7oc4as5483a7T
2 SIWMCCESS = 71 .618837LI5278%6
= S CESS = 12.268185925286578

6. Program to show how to create one or more grid users and submits its Gridlets or task to
many grid resource entities.

Aim: To create a java program one or more grid users and submits its Gridlets or task to many
grid resource entities.

Description:

GridSim supports entities for simulation of single processor and multiprocessor, heterogeneous
resources that can be configured as time or space shared systems. It allows setting their clock to
different time zones to simulate geographic distribution of resources. It supports entities that simulate
networks used for communication among resources. It extends the GridSim class and gains
communication and concurrent entity capability

Source code:

package gridsim.example01;

import java.util.*;
import gridsim.*;

class Example6 extends GridSim
{
private Integer ID_;
private String name_;
private GridletList list_;
private GridletList receivelist_;
private int totalResource_;



Example6(String name, double baud_rate, int total_resource)
throws Exception

super(name, baud_rate);
this.name_ = name;
this.totalResource_ = total_resource;
this.receivelist_ = new GridletList();

// Gets an ID for this entity

this.ID_ = new Integer( getEntityld(name) );

System.out.printIn("Creating a grid user entity with name =" +
name +",and id =" + this.ID_);

// Creates a list of Gridlets or Tasks for this grid user

this.list_ = createGridlet( this.ID_.intValue() );

System.out.printin(name + ":Creating "+ this.list_.size() +
" Gridlets");

public void body()

{
int resourcelD[] = new int[this.totalResource_];
double resourceCost[] = new double[this.totalResource_];
String resourceName[] = new String[this.totalResource_];

LinkedList resList;
ResourceCharacteristics resChar;

// waiting to get list of resources. Since GridSim package uses
// multi-threaded environment, your request might arrive earlier
// before one or more grid resource entities manage to register
// themselves to GridinformationService (GIS) entity.
// Therefore, it's better to wait in the first place
while (true)
{
// need to pause for a while to wait GridResources finish
// registering to GIS
super.gridSimHold(1.0); // hold by 1 second

resList = super.getGridResourcelList();
if (resList.size() == this.totalResource_)
break;



else
{
System.out.printin(this.name_ +
":Waiting to get list of resources ...");

// aloop to get all the resources available
inti=0;
for (i = 0; i < this.totalResource_; i++)

// Resource list contains list of resource IDs not grid resource
// objects.
resourcelD[i] = ( (Integer)resList.get(i) ).intValue();

// Requests to resource entity to send its characteristics
super.send(resourcelD[i], GridSimTags.SCHEDULE_NOW,
GridSimTags.RESOURCE_CHARACTERISTICS, this.ID_);

// waiting to get a resource characteristics

resChar = (ResourceCharacteristics) super.receiveEventObject();
resourceName[i] = resChar.getResourceName();

resourceCost[i] = resChar.getCostPerSec();

System.out.printin(this.name_ +
":Received ResourceCharacteristics from " +
resourceNamel[i] + ", with id =" + resourcelD[i]);

// record this event into "stat.txt" file
super.recordStatistics("\"Received ResourceCharacteristics " +

")

"from " + resourceName[i] + "\"",

Gridlet gridlet;
String info;

// aloop to get one Gridlet at one time and sends it to a random grid
// resource entity. Then waits for a reply

intid =0;

for (i = 0; i < this.list_.size(); i++)

gridlet = (Gridlet) this.list_.get(i);
info = "Gridlet_" + gridlet.getGridletID();



id = GridSimRandom.intSample(this.totalResource_);
System.out.printIn(this.name_ + ":Sending " + info+ " to " +
resourceName(id] + " with id =" + resourcelD[id]);

// Sends one Gridlet to a grid resource specified in "resourcelD"
super.gridletSubmit(gridlet, resourcelD[id]);

// Recods this event into "stat.txt" file for statistical purposes
super.recordStatistics("\"Submit " + info+ "to " +

nn "ll),

resourceNamel[id] + "\"", "");

// waiting to receive a Gridlet back from resource entity

gridlet = super.gridletReceive();

System.out.printn(this.name_ + ":Receiving Gridlet " +
gridlet.getGridletID() );

// Recods this event into "stat.txt" file for statistical purposes
super.recordStatistics("\"Received " + info + " from " +
resourceNamelid] + "\"", gridlet.getProcessingCost());

// stores the received Gridlet into a new GridletList object
this.receivelist_.add(gridlet);

// shut down all the entities, including GridStatistics entity since
// we used it to record certain events.
super.shutdownGridStatisticsEntity();
super.shutdownUserEntity();

super.terminatelOEntities();

System.out.printin(this.name_ + ":%%%% Exiting body()");

public GridletList getGridletList() {
return this.receivelist_;

private GridletList createGridlet(int userlD)
{

// Creates a container to store Gridlets
GridletList list = new GridletList();



intid=0;

double length = 3500.0;

long file_size = 300;

long output_size = 300;

Gridlet gridletl = new Gridlet(id, length, file_size, output_size);
id++;

Gridlet gridlet2 = new Gridlet(id, 5000, 500, 500);

id++;

Gridlet gridlet3 = new Gridlet(id, 9000, 900, 900);

// setting the owner of these Gridlets
gridletl.setUserID(userlD);
gridlet2.setUserID(userID);
gridlet3.setUserID(userlD);

// Store the Gridlets into a list
list.add(gridletl);
list.add(gridlet2);
list.add(gridlet3);

GridSimStandardPE.setRating(100);

// creates 5 Gridlets

int max = 5;

int count = GridSimRandom.intSample(max);
for (inti=1;i<count+l; i++)

{

length = GridSimStandardPE.toMIs(GridSimRandom.doubleSample()*50);

file_size = (long) GridSimRandom.real(100, 0.10, 0.40,
GridSimRandom.doubleSample());

// determines the Gridlet output size that varies within the range

// 250 + (10% to 50%)

output_size = (long) GridSimRandom.real(250, 0.10, 0.50,
GridSimRandom.doubleSample());

// creates a new Gridlet object
Gridlet gridlet = new Gridlet(id + i, length, file_size,
output_size);



gridlet.setUserID(userID);

// add the Gridlet into a list
list.add(gridlet);

return list;

T STATIC METHODS ////111111111111111TTT1TTTTTT

* Creates main() to run this example

public static void main(String[] args)

System.out.printIn("Starting Example6");

try

int num_user = 3; // number of grid users
Calendar calendar = Calendar.getInstance();
boolean trace_flag = false; // mean don't trace GridSim events

String[] exclude_from_file={"" };
String[] exclude_from_processing ={"" };

String report_name = null;

GridSim.init(num_user, calendar, trace_flag, exclude_from_file,
exclude_from_processing, report_name);

// Second step: Creates one or more GridResource objects
GridResource resource0 = createGridResource("Resource_0");
GridResource resourcel = createGridResource("Resource_1");
GridResource resource2 = createGridResource("Resource_2");
int total_resource = 3;



// Third step: Creates grid users

Example6 user0 = new Example6("User_0", 560.00, total_resource);
Example6 userl = new Example6("User_1", 250.00, total_resource);
Example6 user2 = new Example6("User_2", 150.00, total_resource);

// Fourth step: Starts the simulation
GridSim.startGridSimulation();

// Final step: Prints the Gridlets when simulation is over
GridletList newList = null;

newlList = user0.getGridletList();
printGridletList(newlList, "User_0");

newlList = userl.getGridletList();
printGridletList(newlList, "User_1");

newlist = user2.getGridletList();
printGridletList(newlList, "User_2");

System.out.printIn("Finish Example6");

}

catch (Exception e)

{
e.printStackTrace();
System.out.printIn("Unwanted errors happen");

private static GridResource createGridResource(String name)

{

MachinelList mList = new MachineList();

int mipsRating = 377,
mList.add( new Machine(0, 4, mipsRating)); // First Machine

mList.add( new Machine(1, 4, mipsRating)); // Second Machine
mList.add( new Machine(2, 2, mipsRating)); // Third Machine

String arch = "Sun Ultra";  // system architecture



String os = "Solaris"; // operating system
double time_zone =9.0; // time zone this resource located
double cost = 3.0; // the cost of using this resource

ResourceCharacteristics resConfig = new ResourceCharacteristics(
arch, os, mList, ResourceCharacteristics. TIME_SHARED,
time_zone, cost);

// 5. Finally, we need to create a GridResource object.

double baud_rate = 100.0; // communication speed

long seed = 11L*¥13*17*19*23+1;

double peakLoad =0.0;  // the resource load during peak hour
double offPeakLoad = 0.0; // the resource load during off-peak hr
double holidayLoad =0.0; // the resource load during holiday

// incorporates weekends so the grid resource is on 7 days a week
LinkedList Weekends = new LinkedList();

Weekends.add(new Integer(Calendar.SATURDAY));
Weekends.add(new Integer(Calendar.SUNDAY));

// incorporates holidays. However, no holidays are set in this example
LinkedList Holidays = new LinkedList();
GridResource gridRes = null;
try {
gridRes = new GridResource(name, baud_rate, seed,
resConfig, peakLoad, offPeakLoad, holidayLoad, Weekends,
Holidays);
}
catch (Exception e) {
e.printStackTrace();

System.out.printIn("Creates one Grid resource with name =" + name);
return gridRes;

private static void printGridletList(GridletList list, String name)

{

int size = list.size();
Gridlet gridlet;
String indent="";
System.out.printin();



System.out.printin("

System.out.printIn("Gridlet ID" + indent + "STATUS" + indent +
"Resource ID" + indent + "Cost");

for (inti=0; i< size; i++)

{

gridlet = (Gridlet) list.get(i);
System.out.print(indent + gridlet.getGridletID() + indent
+ indent);

if (gridlet.getGridletStatus() == Gridlet.SUCCESS)
System.out.print("SUCCESS");

System.out.printin( indent + indent + gridlet.getResourcelD() +
indent + indent + gridlet.getProcessingCost() );

}// end class

Output:

Starting Examplet

Initialising...

Creates one Grid resource with name = Resource_ 8
Creates one Grid resource with name = Resource_1
Creates cone Grid resource with name = Resource 2
user entity with name =
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6 Gridlets
user entity with name =
4 Gridlets
Starting @rid5im version 5.8

Creating a grid
User_B:Creating
Creating a grid
User_l:Creating
Creating a grid
User_2:Creating

Entities starte
User @:Waiting
User 1:Waiting
User_2:Waiting
User_@:Waiting
User_l:Waiting
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User_l:Receiving Gridlet 4

User_1:5ending Gridlet 5 to Resource 1 with id = 9

User 1:Receiving Gridlet 5

User 1:¥¥%¥ Exiting body()

GridInformationService: Notify all GridSim entities for shutting down.
Sim_system: No more future events

Gathering simulation data.

Simulation completed.

========== QUTPUT for USEF_B T
Gridlet ID STATUS Resource ID Cost

g SUCCESS 9 27.851458885941668
1 SUCCESS 5 39.78779848848887
2 SUCCESS 13 71.6188371352786
3 SUCCESS 5 25.486943940810686

========== QUTPUT for User_l ==========
Gridlet ID STATUS Resource ID Cost

g |SUCCESS 13 27.851458885941668
1 SUCCESS 5 39.78779848848887

2 SUCCESS 9 71.8188371352786

3 SUCCESS 9 3.888155838888753
4 SUCCESS 5 11.493787340618936
5 SUCCESS 9 12.837352690631678

========== QUTPUT for User_2 T
Gridlet ID STATUS Resource ID Cost

g SUCCESS 13 27.851458885941 646
1 SUCCESS 13 39.78779840848887
2 SUCCESS 13 71.6188371352786

3 SUCCESS 13 31.412221561598513

Finish Examples

7. Program to creates one Grid resource with three machines.

Aim: To create a java program one Grid resource with three machines.

Description:

Each instance of the Resource entity represents a grid resource. During simulation, GridSim creates a
number of multi-threaded entities, each of which runs in parallel in its own thread. An entity’s behavior
needs to be simulated within its body() method, as dictated by SimJava. It extends the GridSim class and
gains communication and concurrent entity capability

Source code:
package gridsim.example@1l;

import java.util.Calendar;
import java.util.LinkedList;

import gridsim.*;

class Examplel

{

@SuppresshWarnings ("unused")
public static void main(String[] args)



System.out.println("Starting example of how to create one Grid " +
"resource");

try

{
int num_user = 0;
Calendar calendar = Calendar.getInstance();
boolean trace_flag = true; // mean trace GridSim events/activities
// list of files or processing names to be excluded from any
//statistical measures
String[] exclude_from file = { "" };
String[] exclude_from processing = { "" };
String report_name = null;
// Initialize the GridSim package
System.out.println("Initializing GridSim package");
GridSim.init(num_user, calendar, trace_flag, exclude_from_file,

exclude_from_processing, report_name);

// Second step: Create one Grid resource
GridResource gridResource = createGridResource();
System.out.println("Finish the 1st example");

}

catch (Exception e)

{
e.printStackTrace();
System.out.println("Unwanted error happens");

}

@SuppressWarnings("deprecation™)
private static GridResource createGridResource()
{
System.out.println("Starting to create one Grid resource with " +
"3 Machines ...");

MachineList mList = new Machinelist();
System.out.println("Creates a Machine list");

int mipsRating = 377;

mList.add( new Machine(®, 4, mipsRating)); // First Machine

System.out.println("Creates the 1st Machine that has 4 PEs and " +
"stores it into the Machine list");



mList.add( new Machine(1, 4, mipsRating)); // Second Machine
System.out.println("Creates the 2nd Machine that has 4 PEs and " +
"stores it into the Machine list");

mList.add( new Machine(2, 2, mipsRating)); // Third Machine
System.out.println("Creates the 3rd Machine that has 2 PEs and " +
"stores it into the Machine list");

String arch = "Sun Ultra"; // system architecture

String os = "Solaris"; // operating system

double time_zone = 9.0; // time zone this resource located
double cost = 3.9; // the cost of using this resource

ResourceCharacteristics resConfig = new ResourceCharacteristics(
arch, os, mList, ResourceCharacteristics.TIME_SHARED,
time_zone, cost);

System.out.println();
System.out.println("Creates the properties of a Grid resource and " +
"stores the Machine list");

// 5. Finally, we need to create a GridResource object.
String name = "Resource_0"; // resource name
double baud_rate = 100.0; // communication speed
long seed = 11L*13*17*%19%23+1;

double peaklLoad = 0.0; // the resource load during peak hour
double offPeakLoad = 0.0; // the resource load during off-peak hr
double holidaylLoad = 0.90; // the resource load during holiday

// incorporates weekends so the grid resource is on 7 days a week
LinkedList<Integer> Weekends = new LinkedList<Integer>();
Weekends.add(new Integer(Calendar.SATURDAY));

Weekends.add(new Integer(Calendar.SUNDAY));

// incorporates holidays. However, no holidays are set in this example
LinkedList<Integer> Holidays = new LinkedList<Integer>();

GridResource gridRes = null;
try
{
gridRes = new GridResource(name, baud_rate, seed,
resConfig, peakLoad, offPeakLoad, holidaylLoad, Weekends,
Holidays);
}
catch (Exception e) {
e.printStackTrace();

}

System.out.println("Finally, creates one Grid resource and stores +

"the properties of a Grid resource");

return gridRes;



Output:
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